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Learning Objectives
o Effortlessly upload files to the Autodesk Cloud.
e Manage, share, markup, and visualize your data in the Cloud.
e Access and edit your Cloud data direction from your desktop.
e Use Fusion Mechanical with the cloud data management solution.
Description

In this hands-on lab, we will walk you through our cloud data management solution, teach
you how to automatically upload and update your data from the familiar workspace on your
desktop, and allow you to explore the wide range of functionality provided to you by the
Autodesk cloud services. Come to this course to grab the wheel and take a spin through our
cloud data management experience.

Your AU Expert(s)
Adam Luttenbacher

Adam Luttenbacher is a product owner for Autodesk, Inc.’s desktop and cloud data
management solutions. With over 14 years of experience, Adam has played a significant role in
improving both the user's experience and the product quality of Autodesk's data management
applications. Educating and interacting directly with the user community at Autodesk University
each year has been a top priority for Adam.

Craig Godfrey

Craig Godfrey is an employee of Autodesk working in various areas of the Fusion platform in the
Novi Michigan office. Craig has worked at Autodesk for 14 years, with various roles such as
quality assurance, experience design, and now product owner. With a primary focus on Data
Management (Vault & Fusion Lifecycle) his goal is to provide quality functionality and improve
the user experience along the way.
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Introduction

In this hands-on lab, we will walk you through our cloud data management solution, teach
you how to automatically upload and update your data from the familiar workspace on your
desktop, and allow you to explore the wide range of functionality provided to you by the
Autodesk cloud services.

New users of Fusion will get their own place to store and manage their data. This lab begins

with the “cake already in the oven”. A team “hub” has been created and configured for all lab
attendees.

Information You Will Need to Get Started

e Hub Name: ADSK Fusion Username
e URL: https://gmail112570.autodesk360.com/ autodeskfusion+01
e Username: Refer to your card. Password
e Password: Fusion01 v Fusion01

Data Management in the Autodesk Cloud

l. Log into Fusion
The web site you need to go to has been saved as a favorite in your Chrome web browser. Click
there to get to the website.

Steps to log into Fusion
1. Fillin the username and password from your information card.
2. Choose Sign In.

-

Sign In

adam.luttenbacher@autodesk.com
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Il. Explore the Fusion Space

Once logged in, you are looking at all of the Fusion projects that are available to you (based on
your permissions). Here is a breakdown of the interface:

General Layout

Team ADSK Fusion

ALL | OV BY ME ITH Create Project Activity
600
j Mana T
Managing Your Cloud Data Craig Godfrey Aug 23,2017

Spindle Drawing

Activity

Data Pane Details
~Pane.

PRD_Router Rev k

Craig Godfrey updated 1o

Administration & Settings

You can access your personal settings by clicking on your profile image. If you have
admin privileges you will have additional options to configure your team hub. If you
belong to multiple hubs you have the ability to switch between them.

Steps to switch Hubs

1. Select your user profile in the upper right corner
2. Choose the “Team ADSK Fusion” hub.

Adsk Fusion+01
k Fusion Oct 23, 2017 {

Team ADSK Fus

—

Blade Guard Base.SLDPRT
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lll. Take a Look at Projects

Fusion Team offers Open, Closed, and Secret projects. Open projects are wide open to all
users in a Fusion hub. Closed projects can be viewed by all and accessed when granted
permissions. Secret projects are only viewable and accessible to those granted permissions.

An open project for all class attendees called, “Managing Your Cloud Data” has been created
in the Fusion hub. The administrators of this space have configured this project to be available
to all class attendees.

Steps to find and view the open project
1. Select the Managing Your Cloud Data project. This will open the project and by
default display its data.

In addition to Data, which is the default view, a project can manage other information that
project members have access to view, create and update. Let’s explore other aspects of a
project such as Calendar, Discussions, and Wiki pages. We will return to Data later in the lab.

Steps to access Data, Calendars, Discussions, and Wiki Pages:
1. Select the drop down above the projects activity feed & Details panel
2. Take some time to explore each area found in the drop down

M DATA
[ CALENDAR
B DISCUSSIONS

[E wikiPAGES
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Calendar - Track important project dates and events

Managing Your Cloud Data

ata > Calendar B CALENDAR v

November 2017 < > + Add

® :
.

300PM

| 12:00 AM

330PM

3:00PM

Discussions - a way for you to have conversations within a project

A > ManagingYour..ata > Discussions B3 DISCUSSIONS v

g8
i_ Craig Godfrey & Managing Your Cloud Data

Welcome to Managing Your Cloud Data!

1k g t t I € Y

e , More PROJECT MEMBERS (58) [ invee |

o (@ AdamLuttenbacher
Craig Godfrey Project Admin
Y craig godfrey@autodesk

Adam Luttenbacher Editor
adam luttenba...r@autodesk.com

ADSK Fusion+19

autodeskfusion+19@gmail.com Editor
ADSK Fusion+11 i
autodeskfusion+11@gmail.com itor
autodeskfusion+01@gmailcom  E9ItOr
ADSK Fusion+41

Editor

autodeskfusion+41@gmail.com

ADSK Fusion+45 i
autodeskfusion+45@gmail.com or

View and Manage Members

e Adsk Fusion+01
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Wiki Pages - create content on a variety of topics related to your project

®  ® [ Managing Your Cloud Data- - x ' {\ Help: About Wiki Pages % {\ Overview | Autodesk Universi' x = [= Desktop Connector Solution - x Craig

75476/pages/PGabee1QT1a327¢f2b7a5/93d80b6dda64b3?show=comments w @ (0] (]
» [ Other Bookmarks

= C () @ Secure https://fusionau.autodesk360.com/g/projects/20170823892
i Apps Infosys § FLC Jira [ ADSK £ Personal [X)Hogwarts [ Things to look at £ Fusion Lifecycle £ Fusion [ Autodesk £DSGN Flcc [l Stock ¢ Blue Team Dashboa...

COMMENTS

% Managing Your Cloud Data

|Add a new nent

MFG125066-L: Managing Your Cloud Data .

rning

in the Cloud

your desktop. i Craig Godfrey

* Manage, share, markup, and v

 Access and edit your Clou

* Use Fusion Mechanical with the cloud date management solution.

Description

In this hands 1 you how to automatically upload and

onality provided
ata

our cloud data

anagement sc

your desktop, and allow e range of

o this course to grab n through our ¢

management experience

Your AU Expert(s)

Adam Luttenbacher

IV. Create a New Project
You will create your own project to work in. You can choose any type of project to create. Here

are the differences:

e Open — All hub members can view and modify content of this project.
o Closed — All hub members can see the project but access is restricted to those

with permission.
e Secret — Only you and invited users can view and modify content of the project.
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Settings

Project Type

This setting determines who can view your project and access its data.

") Open
Any Team Member can ask to join this project (Please note, Projector Contributor access is restricted)

© Closed
Only invited members can access this project.

7 secret
Only invited members can see this project.

O Allow Project Contributors (There are 0 Project Contributors.)

Steps to create your project
1. Choose the “Create Project” button from the home page of the hub.
2. Use your username for the project name and choose an image.

Create Your New Project

Project Name(required) You have 51 characters left

AUFusion1

Choose a Project Avatar(required)

Upload
Your Own

Cancel ‘ Create Project
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3. Select Create Project button.
4. Result: You are viewing the project with no content.

Steps to change the project type if you change your mind

1.
2.

In the Details pane, choose the gear icon.

In the Settings dialog, choose the type you prefer.

V. Manage Project Members
Now that you have created a new project, you can invite members to it. You will just need their
email address and assign a role.

PROJECT ACCESS LEVELS

project
Project Admin

Project settings, approve people in project,
set access levels

Viewer Editor
View
Files(online), folders, comments(view and v v
post) and people
Discussions & Calendar v v
Access to conversations and events
Get Link and Live Review
Get link for shared files and initiate live v
review
Edit, Upload, Download v
Copy, move, rename and delete files/folder
Manage Sharing
Enable and set public sharing, invite others to v

Project
Admin

v

v

Steps to invite members

1.
2. Enter an email address. Feel free to add autodeskfusion@gmail.com

Select the Invite button from the Details pane.

3. Choose a role from the picklist.

Who do you want to invite to this project?

Email addresses or names of the people you'd like to invite(required)

autodeskfusion@gmail.com ¥

Don't use mailing lists.)

t Contributo in this Project

1invite w as Project Contributors into this hub.

Cancel

Send Invitations
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VI. Create a Folder Structure in Your Personal Project
Treat this project as your own workspace and create a folder structure that would be logical to
support your daily work activities.

Steps to create a folder structure

1. From inside of your personal project, choose New > Folder.

2. In the Folder Name field, create a folder named Office Files.
3. Choose Create and notice the folder is created in your project.
4. Create another folder named Design Data.

5. Choose Create and notice the folder is created in your project.
Note: Files will be added to these folders later in the lab.

Name a

[@ Wwiki Pages

Ml Folder
Design Data h
Office Files h

) Fusion Design

Connected Desktop — Access Your Cloud Data from Your Workspace

Desktop Connector is a utility installed on your lab

machine that will allow you to upload and modify data in o @@D 10:54 AM
the cloud. It's always on and waiting for you in the system 11/1/2016
tray.

l. Log into the Cloud
Your Autodesk ID is the common key used to identify you and give you access to all of the
Fusion functionality.

Steps to log into the cloud

1. Right-click on the Autodesk Drive system tray icon.
2. Choose “Sign In” from the menu.
3. Enter the username provided for you: autodeskfusion+<number>@gmail.com
(see card)
a. IMPORTANT: use the same account you used to log into Fusion.
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Sign in l\
|

NEW TO AUTODESK?

Username
autodeskfusion+01
Password
' Fusion01
4. Choose NEXT.

5. Enter the password: Fusion01

Il. View Hubs and Folder Structure
Now that you are logged in, you are connected to the same workspace you set up in Fusion.
You can navigate into your Fusion connector and explore the workspace.

Steps to View your project

Open the Fusion drive in Windows File Explorer.
Notice the open projects and your project is available.
Explore the workspace.

W=

lll. Add Data to the Cloud
Adding data to the cloud is simple with Desktop Connector. By saving files to the Fusion
workspace, they will be uploaded to the cloud for you. In this step, you will be uploading the

data to the cloud using a drag-and-drop copy command.

Steps to add office documents to the cloud
1. Navigate to C:\Datasets\Adam Luttenbacher

2. Shift-select the files.
3. Drag-and-drop files from the location in step 1 to your projects “Office Files” folder in

your Fusion project.
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| 2

= | Adem Luttenbacher - o AU Fusion - o
Home  share  View of « 1 ||« ADSKFusion > AU Fusion=01 vo »
« v 4 [« DATASETS > Adam Luttenbacher v ®] | Search Adam Luttenbacher 9
R Org m @
& Pictures A Name Type
# Quick access
8 Videos Inventor Saw 11/10/2017 1:21 PM  File folder
& Local Disk (C) [ Lab PowerPoint.pptx 11/10/20171:24PM  PPTX File @ OneDrive
T7d166524b€0d0751d0687E 7] Lab Text Filext 11/10/2017 1:21PM  Text Document t [ This pC
Avtodesk E) Lob Word Documentdocx 11/10/2017121PM _ Offce OpenX ~ a0 ehmical Document.
DATASETS B 8IM360 Team

Adam Luttenbacher

B

SOLIDWORKS Data
temp

TESTDATA

Users

Windows

XML

4items  3items selected 480 MB

rogram i \
rogramFies 651

4. With the files added through Desktop Connector, they are automatically uploaded to

Fusion.

Steps to add design data to the cloud

1. Navigate to C:\Datasets\Adam Luttenbacher\Inventor Saw
2. Drag-and-drop only file Reciprocating Saw Assembly Top Level.iam from the
Local folder on your machine to the “Design Data” folder you created in your project.

4 [1 5 | inventor Sow - o x \
B ore s view of o 2 ([« ADSKFusion >
« A [ « Adam Luttenbacher > Inventor Saw v & | sesrchinvent »
org
& Pictures A Nome

B Videos
‘a Local Disk ()
77d166224b€0d075140687E
Autodesk
DATASETS
Adam Luttenbacher
ECs

(B Battery Plugam
Blade

Installs

Inventor 2017

orip
() Battery Plug (Bottom).ipt
() Battery Plug (Top).ipt

SOLIDWORKS Data

temp () Battery Plug Clip.ipt
TESTOATA () Battery Plug Shaft.ipt
Users () Battery Plug Spring.ipt
Windows. () Big Gear Shaft.ipt
XML (1) Blade Guard Base Pin.ipt
= PO,
v<
68 lected 2.37MR

B This PC
& A360Drive
B BIM 360 Team

AU Fusion+01 vo »
- m @
A Nome ted B
Design
Marketing
Sales
Technical Documen ts
V<

3. You will be asked to select an ipj, “reciprocating saw.ipj” is included in the data set

I\ Select an Inventor Project File X

Moving Inventor files into the Autodesk Desktop Connector
workspace requires the selection of an Inventor project file. Select a
project file relevant to this data.

Selected project file:

4. Notice the related data is copied in to the folder with it.
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So what? Move one file — get all files = smart data management. Autodesk Drive is watching
the kind of data you are moving in and out of the cloud. When it recognizes the file type, it
cracks the file open and searches for related data. This means you can drag the top-level file
and Autodesk Drive will bring all of the child assemblies and parts for you.

IV “Go To” the Cloud Data

The files you see in the Fusion workspace are stored in the cloud. To view the file in the cloud,
you can use the Go to command on any file.

Steps to Go to on a file
1. Navigate back to the “Manage Your Cloud Data” Project
2. Go into the “Reciprocating Saw” folder

3. Right-click on “Reciprocating Saw Assembly Top Level.iam” and choose the Go
to command.

M Reciprocating Saw Inventor = O X
&« v « Fusion 360 > ADSK Fusion » Managing Your Cloud Data > Reciprocating Saw Inventor v U  Search Reciprocat.. R
Organize ~ = m @
32 Dropbox A O Name - Created By File Size ~
[ Reciprocating Rod.ipt Craig.Godfrey 160 KB
& OneDrive M3 Reciprocating Saw Assembly Top Level.iam - 2.37 MB
& This PC 2] Reciprocating Saw Harness Assembly.iam Z:i:m 61.0 KB
B BIM 360 Team /_j Reciprocating Saw Harness.ipt —— 130 KB
() Rod Clip.ipt py Hin 114 KB
= Desktop £ Rotor Arm.ipt 133K8
& Documents E—J Short Rod Assembly.iam 75.5 KB
# Downloads () Short Rod.ipt 935 KB
[F Fusion 360 () Small Bushing.ipt 82.5 KB
b Music () small Spur Gear.ipt Craig.Godfrey 187 KB
= Pictures & Snap Hook Assembly.iam Craig.Godfrey 122 KB
& Videos () Snap Hook Base.ipt Craig.Godfrey 195 KB
8 Windows (C) /jj Snap Hook Slider.ipt Craig.Godfrey 102 KB
1) Snap Hook Spring.ipt Craig.Godfrey 253 KB
& Network [ Snap Hook.ipt Craig.Godfrey 292 KB
+4 Homegroup % Trigger Assembly.iam Craig.Godfrey 90.5 KB
& Trigger Box Collar.ipt Craig.Godfrey 131 KB v
v < >
66 items 1 item selected El =]

4. Result: Fusion opens showing an overview of the file.

Page 12



{\ AUTODESK
UNIVERSITY

> B

Reciprocating Saw Assembly Top Level.iam v~

Inventor assembly files | 24MB |  Shared Link COMMENTS

@ ast Updated on 8 hours ago Start & conversation
3y Craig Godfrey

Design References

USES (24) USED IN DRAWINGS

J
1 JISB1111-AM4X8... Vi Gear Housing Cover ... V.1

v P

Fusion Data Management

Blade Holder Assem \Al
-

Now that you have added your data, let’s take a look at what you can do to manage it within the
system. Data Management is more than storing versions of data, let’s take a look how you can
organize, view, share, and communicate with others about the data.

Mo

| Overview and Related Data

In addition to viewing the design you can view the associated data. What other files are
referenced by the design, who has commented on the design, how many changes over time
have happened, and who made those changes?

Explore the “Overview” page:

1. Design References
e Uses - child components that make up the file you are viewing.
e Used In - all files that consume the particular file you are viewing.
e Drawings - associated drawing files for the file you are viewing.

2. Comments
o View comments created by yourself or others regarding the particular file.

3. Related Data

e The following types of design data are shown here depending on the file
type: Simulations, Renderings, CAM, Views, Animations, etc.
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Il Large Model View of Data in Fusion
The viewer in Fusion offers a lot of powerful functionality, let’s take a look at some of the
capabilities available.

Steps to Viewing the model:
1.

From the “Overview” page select the “View” button

Once the View is loaded expand the File Structure
In the upper-left corner of the viewable, choose the Scene
button. This will expose an overlay of the file structure. Select @
objects, search for objects, and expand the tree structure.

3. Isolate Components in Assembly
After expanding the structure, select a sub-assembly or component to isolate the
object in the image.

» Blade guard Assembly
» Blade Guard Base

» Blade

» Battery Connector

» Trigger vt

4. Create a Mark Up on the file
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The mark up tool allows consumers to use a variety of tools to make notes on the
visualization. Mark-ups are stored as comments on the file. Choose the file in the
grid/list to see associated mark-ups.

¢ /00 8 u8T|| e

5. Add Comments
Comment on Objects — Choose the “objects” option to associate comments with
specific objects in the assembly.

Comment on Points — Choose the “points” option to insert comments to any point
in the visualization.

.

Comments created here will be available on from the visualization and the
overview of the assembly.
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6. Explode Assembly
This command allows the consumer to view the assembly in varying levels of
exploded views.

Il. Working with Your Data

Users do not want to have to go to the cloud just to do their job. They want to work from the
place they are comfortable — their desktop. This section will cover making modifications or
creating new files on disk, and will highlight the syncing of data. Here we will use the Simple
files data set but you can use any files you have added to the system.

Steps to Rename files

If you need to rename a file you can choose to do so on the desktop or in Fusion. Let’s
make the edit on the desktop and see how Fusion stays in sync.

1. In Windows Explorer navigate to the personal project you created in the ADSK

Fusion Hub.
2. Right click on the “Lab Word Document.docx” and select Rename
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3. Give the file a new name “Name Changed.docx”

n My Office Files

<« v P > This PC > Fusion 360 > ADSK Fusion > My New Project > My Office Files
Organize ~

~
A
© Creative Cloud Files 0 Name

Created By

o X .
22 Dropbox @ Lab PowerPoint.pptx autodeskfusion90

[ Lab Text File.txt
& OneDrive

autodeskfusion90
Lab Word Document.docx autodesffucianan.
Open...
= This PC
Go To
B 8IM 360 Team S
m Desktop
Export...
[ Documents
& Downloads X Delete
[ Fusion 360 Rename
¥ ADSK Fusion

Managing Your Cloud Data
My New Project
Design Data
My Office Files
) Music
= Pictures

B Videos

3items 1 item selected

Steps to Move Files

O

X

v U Search My Office ... 2

File Size

1.95 MB
4.52 KB
2.82 MB

m @

If you need to move your files to a new location simply follow the steps you do today
using windows explorer. Let’s create a new folder and move existing files to that

location.

Search My Office ... 2

E -
File Size

1.95 MB
4.52 KB
2.82 MB

m @

1. Right Click in the white space of “My Office Files” and select New Folder
2. Name the folder “Office Documents”
W My Office Files
&« v N > This PC > Fusion 360 > ADSK Fusion » My New Project » My Office Files v 0
Organize ~
= This PC A O Name - Created By
B BIM 360 Team %) Lab PowerPoint.pptx autodeskfusion90
m Desktop [7 Lab Text File.txt autodeskfusion90
& Documents ﬂjg'] Name Changed.docx autodeskfusion90
Office Documents
# Downloads
[ Fusion 360
¥ ADSK Fusion

look like

3. Drag and Drop the PowerPoint and Word file into the new folder. The result should

the following
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l My Office Files

« v > This PC » Fusion 360 > ADSK Fusion > My New Project » My Office Files v 0
Organize ~
A~
= This PC A O Name Created By Version
B 8IM 360 Team Office Documents
m Desktop || Lab Text File.txt autodeskfusion90 1
[ Documents
& Downloads
[F Fusion 360

Making Edits using the Native application

(] X

Search My Office .. @

File Size

4.52 KB

o @

With Desktop Connector, you continue to use the native application to create new

documents and edit existing ones.

1. Open the “Lab Text File” (double click or right click and choose open)

2. Make a change to the document
3. Save and Close the application

Reviewing all of the edits

We have made changes on both the desktop and in the cloud. Let’s see how those look

in Fusion.

1. Right Click on “Lab Text File.txt” in windows explorer and choose Go To

2. The Overview page for the file is opened in your browser
3. Inthe bread crumb navigate back to “My Office Files”

Team ADSK Fusion

My New Project

A > MyNewProject > My Office Files

Moves and Renames
match the changes made
on the Desktop

Name a

il Office Documents

Adsk Fusion+90

B Lab Text File.txt Adsk Fusion+90

Version has updated to
reflect the edits you made

in the native application
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Promote a previous file version
There will be times when a previous version of a file needs to be promoted so it is the
latest. For example, the edits that we made to the Lab Text File should not have been
done so we need to return the document to its original state. Let’'s head back to the
cloud!

1. Select the version drop down

2. You will see the original upload version as well as the version for the edits that

you made on the desktop.
3. Hover over version 1 and select the Promote button

Adsk Fusion+90

2

Adsk Fusion+90

1

When asked if you would like to confirm the promote say yes.
Now when you view the version drop down you will see version 3 was created
which restored the document to its version 1 state.

o s

Adsk Fusion+90

3

Adsk Fusion+90

2

Adsk Fusion+90
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lll More Fusion Capabilities
In this section, you will explore more capabilities of Fusion.

Sharing Data with Others

1.

2.
3.
4

5.

6.

Navigate to the managing your data project

Select the “Fusion 360 Data Set” folder

Hover over any file in the table, notice a set of commands are shown
Select the share button

Managing Your Cloud Data

> Managing Your ..ata > Fusion 360 Data Set
ging

Name
P Skeleton - Master Craig Godfrey Fusion Design Aug 31,2017
@ Skeleton - Z to X Interface Craig Godfrey Fusion Design Aug 31,2017
P spindle Craig Godfrey Fusion Design Aug 31,2017
@ « Spindle Assembly Craig Godfrey Fusion Design Aug 31,2017

A
le
<

spindle Assembly Drawing #' Craig Godfrey Fusion Draw... Sep1,2017

Spindle Drawing Craig Godfrey Fusion Draw. Sep 1,2017

2

W _Teolfincar Craia Gadfean CucianDasian Aiand2017

Once selected you can choose how you want to share the file
e Copy the link and share it
o Email the link to an external stake holder
o Embed the file in another application
You can also choose from various security settings
e Enable or Disable the file to be downloaded when shared
e Require a password in order to view the file
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w
)
[%]
™

o Shared Link is ON for Lab Text File.txt

Copy Link Email Embed

Send a link to

autodeskfusion@gmail.com

Personal Message

Check out this complex text document | just created.

Privacy Settings

Allow viewers to download to their computer

Comparing Versions

If you are managing Fusion 360 data you have the ability to compare versions to see the
details of what has changed between them. You can view components that have been

added, removed, or modified.

1. Select the Spindle Assembly
2. Go to the View tab and select the version drop down

View

Spindle Assembly

Versions Compare versions
4 Craig Godfrey &

% Las l fart a conversatior
By Crz
Design References
P ‘ Craig Godfrey
USES (4) JSED IN DRAWI
1 ‘ Craig Godirey
Zshaped DryerHose Wil | Spindle VAl ANSIBIE3-632UN.. WAl | | ANSIBIS3-832UN.. W

3. Choose Version 4 against Version 3 and select compare
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Design v ‘

4. Once open you have the ability to visually compare the files using various filters
e ltems added
e Items Removed
¢ Items Modified
e Selecting one of these from the list view will provide more details as well as
highlight the change in the model itself

6453K144:4 (Body1)

Editing in Fusion 360

In addition to editing files in native applications using Desktop Connector as well as
modifying data once it is in Fusion team, you also have the ability to create/modify data
directly in Fusion 360 from Fusion Team.

1. While on the View or Overview page of the “Spindle Assembly” select the pencil
icon in the upper right corner of the screen
2. Choose Edit on Desktop
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Spindle Assembly v~

COMMENTS
Fusion Design | Shared Link

@ ast Upoated on 8:48 AM August 31, 2017
8y Craig Godfrey

Design References

USES (4) JSED IN DRAWINGS (1)

%

Z shaped Dryer Hose spindle 632UN... Wil ANSI B18.3 - 8-32

3. Fusion 360 is launched and the Spindle Assembly is open.
4. Take a look around and make some modifications.

Autodesk Fusion 360 X
i R H &~ @®  AdskFuson0y @~

@ spindieAssemblyva O X | +

I UooU@a @ Br 0 = bl o &

SKETCH ¥ CREATE ¥ MODFY~¥ = ASSEMBLE™ = CONSTRUCTY = NSPECT™ = INSERTY MAKE™ =~ ADD-NS™ = SELECT™
« BROWSER ol | 'S
PR * o soinic Assemoiy vi_[O)

D 4 Document Settings
B Named Views
Q Origin
Joints
Sketches
Construction
Spindle Plate Mount:1
& Spindie vi:1
Bottom Plate LEFT1

Q3LYYLS ONILLZD

Bottom Plate Right:1
6453K144:1

6453K1443

Below Plate: 1

(J @@ AnsiBIB3-8-32UNC-1(31
(0 DustCollector:1

(O @ Zshaped Dryer Hose vi:1

R RV RV R R R R R R R
Qo000 R0B000

Lol ol ol ol ol ol ol ol ok o o ok ok ol o

COMMENTS - o 69 Q Q- @ E B
Her»H JPJRICEIEESARODRBIRODNRISIPIIIBDIRIBRIIBIBIDORGAODNRIRIBIJERID ©
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